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Clear Search button.
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retrieved user notes
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notes and user note search results.

3. Search user notes Added information about using the Search History function to view, 
revise, and reuse previous user notes searches.

November 2003 1. Create user notes; 
2. View and edit user 
notes; 4. View 
retrieved user notes

Revised to document the new work area dialog box that lets you use 
the work area without scrolling to the top of a long record.

December 2003 3. Search user notes Added information about using left truncation in user notes 
searches.

February 2004 2. View and edit user 
notes

Updated information on using the Active Records screen.

3. Search user notes Documented new keystroke to move to search screen for 
WebDewey User Notes (<Ctrl><Shift><[> or Abridged WebDewey 
User Notes (<Ctrl><Shift><]>).

May 2004 2. View and edit user 
notes

Documented new option to turn off logoff warning for active records.
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Create and Manage Dewey User Notes
1 Create Dewey user notes

Why create user 
notes?

Notes attached to DDC records provide quick access to guidelines that reflect 
local classification practices.

Personal notes help individual catalogers classify similar items consistently 
over time.

Institution notes promote consistent classification by multiple catalogers with 
varied specialties and experience.

Notes preserve decisions about classification, saving time by avoiding 
duplication of intellectual effort.

Personal user notes Available with a single license or site license for WebDewey or Abridged 
WebDewey.

Personal notes are associated with the authorization number of the user who 
creates the notes.

Only the individual who creates a note can retrieve it from the notes database 
or view the note from a DDC record. Personal notes are not shared with other 
users at an institution.

Institution user notes Available with a site license for WebDewey or Abridged WebDewey.

Institution notes are associated with the library’s OCLC institution symbol.

Institution notes are shared with all users at the same institution. Any user can 
retrieve notes from the notes database or view notes associated with a DDC 
record.

User notes storage Notes reside on the WebDewey server, not on a disk drive at the user’s site.

Users who license both WebDewey and Abridged WebDewey have two 
separate notes databases, one for each service.

For an institution with a site license, the notes database contains both institution 
notes (shared by all users from that institution) and personal notes (available 
only to the user who creates the note).

Fields in Dewey user 
notes

Field Purpose Required?

DDC# Identify the number to which the note applies 
(if any).
Use a number from the schedules, tables, or 
manual.

No

Title Describe content of note. Indicate when or 
how the note applies to a classification task.
Displayed in brief entries for retrieved notes in 
search results.

Yes
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Create and Manage Dewey User Notes
Create user note from 
blank workform

Type of Note Enable selective display of notes by type.
Enable use of note type as a restrictor 
(qualifier) when searching the notes database.
Institution notes require site license
Only users with a site license for WebDewey 
or Abridged WebDewey can create institution 
notes. With a single-user license, you can 
create personal notes only.

Yes

Keywords Provide additional terms to facilitate retrieval of 
the note.
Multiple keywords. If you enter multiple 
keywords, separate the keywords with a 
comma or semicolon.

No

Note Content of the note. Can include: Instructions, 
guidelines, tips, supplemental information, 
examples of numbers built according to your 
library’s practice, and/or examples of subjects 
to classify under the number.

Yes

Field Purpose Required?

Action

1 On the Dewey Services tab, under Create Options, click User Notes or Abr. 
User Notes.
A blank note workform appears.

2 DDC# field (Optional)
In the DDC# box, type the number (from the schedules, tables, or manual) to 
which the note applies.

3 Type of Note (Required)
At the Type of Note field, select Institution Note or Personal Note.
Site license. If you have a site license for WebDewey or Abridged WebDewey, 
the Type of Note field shows the default note type you specified on the 
WebDewey Options screen. Change the type if desired.
Single-user license. If you have a single-user license for WebDewey or 
Abridged WebDewey, Personal Note is automatically selected.

4 Title (Required)
In the Title box, enter a title that indicates the subject or purpose of the note.

5 Keywords (Optional)
In the Keywords box, type 1 or more words that represent the subject or 
purpose of the note.
Include terms that you (or others) might use when searching for this note.

6 Note (Required)
In the large text box, type the content for the note.
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Create and Manage Dewey User Notes
Create user note from 
DDC record

7 Proofread the note and correct any errors.

8 Add the note to the notes database.
Open the Actions list and click Save Note.
Click OK to confirm that you want to save the note.
The system displays a confirmation message.

DDC number check (new user note)
When you save a new user note for the first time, the system searches the 
WebDewey or Abridged WebDewey database for the number you supplied in 
the DDC Number field of the user note.
If the number you supplied does not exist in the DDC database searched, the 
system asks you to decide whether or not to save the note.
To save the note anyway, click Yes.
To cancel saving the note and correct it as appropriate, click No.

Action

Action

1 Retrieve the DDC record you want to annotate.

2 At the top right corner of the record screen, click Create Note.
The system opens a new browser window that contains a Dewey Note 
workform.
The DDC# field contains the number represented by the DDC record.
Brackets and parentheses not transferred. When you create a note for a 
DDC number surrounded by square brackets or parentheses, the number is 
inserted in the Dewey Note workform without the surrounding punctuation.

3 Complete the new note.
Enter text to provide appropriate information or instructions.
Fill in the required fields: Title, Type of Note, and Note.
Proofread the note and correct any errors.

4 Add the note to the notes database.
Open the Actions list and click Save Note.
Click OK to confirm that you want to save the note.
The system displays a confirmation message.
When you retrieve the annotated DDC record, your note appears in a box 
labeled User Notes. User notes follow notes that are part of the DDC (labeled 
Notes).
Click the Notes button in the top right corner of the record screen to jump to 
the Notes area.

DDC number check (new user note)
When you save a new user note for the first time, the system searches the 
WebDewey or Abridged WebDewey database for the number you supplied in 
the DDC Number field of the user note.
If the number you supplied does not exist in the DDC database searched, the 
system asks you to decide whether or not to save the note.
To save the note anyway, click Yes.
To cancel saving the note and correct it as appropriate, click No.
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Create user note from 
an existing note 
(Derive New Note) Action

1 Search the Dewey notes database to retrieve the note you want to use as a 
model for creating similar notes.
Or
Create a note with characteristics you want to replicate in one or more other 
notes (a template note).
View the note in display mode or edit mode.

2 Open the Actions list and click Derive New Note.
Click OK to confirm that you want to duplicate the note.
An exact copy of the original Dewey note appears, in edit mode.

3 Complete the new note.
Add, delete, or change text to provide appropriate information or instructions.
Fill in the required fields: Title, Type of Note, and Note.
Proofread the note and correct any errors.

4 Add the note to the notes database.
Open the Actions list and click Save Note.
Click OK to confirm that you want to save the note.
The system displays a confirmation message.

DDC number check (new user note)
When you save a new user note for the first time, the system searches the 
WebDewey or Abridged WebDewey database for the number you supplied in 
the DDC Number field of the user note.
If the number you supplied does not exist in the DDC database searched, the 
system asks you to decide whether or not to save the note.
To save the note anyway, click Yes.
To cancel saving the note and correct it as appropriate, click No.
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Work area: build a 
DDC number

Use the work area to
—Build a classification number incrementally. Type a base number in the work 

area box and then add to the number as you read number-building 
instructions.

—Keep the number you are building on the screen while viewing relevant 
schedule and table records, following instructions in add tables, consulting 
Manual entries, or checking user notes.

The work area appears by default at the top of results lists, schedule and table 
records, and user notes.

Work area dialog box. The work area does not remain in view as you scroll 
down through a long record. To continue building a number in the work area 
without scrolling up and down, use the work area dialog box. Press 
<Alt><Shift><.> (period) to open the dialog box. Type the data you want to add 
to the number you are building. Then click OK or press <Enter> to store the 
information in the work area.

If you do not use the work area, you can hide it by changing the default setting. 
On the Dewey Services Options screen, under DDC Record Options, change 
the Work Area setting to Hide.

If you use the work area occasionally, leave the option set to Show. Then, to 
show or hide the work area as needed, press <Alt><W>.

Contents of the work area are retained between Connexion sessions. The work 
area is not cleared when you log off.

Browser requirements: The work area is available only in supported versions 
of Internet Explorer with cookies enabled.
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Work Area function How to use

Show or hide work area On a Dewey Services results, record, or user 
note screen,

Press <Alt><W>.
Note: The keystroke works only if the Work 
Area option is set to Show in Dewey Services 
Options.

Move cursor to work area Press <Alt><.> (period).
Connexion places the cursor in the work area 
and highlights any existing text.

Open work area dialog box Press <Alt><Shift><.> (period).
The dialog box appears, containing any data 
currently stored in the work area.

Close work area dialog box; 
save changes to the data 
stored in the work area

Click OK or press <Enter>.
The contents of the work area are updated with 
any changes made since you opened the dialog 
box.

Close work area dialog box; do 
not save changes to work area 
contents

Click Cancel.

Change Work Area setting
Default: Show

1. On the General tab, under Admin Options, 
click Preferences. At the Preferences 
screen, click Dewey Services Options.

2. On the Dewey Services Options screen, 
under DDC Record Options, select Show or 
Hide for the Work Area item.

3. To use the setting for the current session only, 
at the top or bottom of the Dewey Services 
Options screen, click Save for Session. To 
use the settings for future sessions, click 
Save My Default.
page 9 of 29



Create and Manage Dewey User Notes
Copy and paste text 
from Dewey for 
Windows user note

This section explains how to reproduce Dewey for Windows notes for use in 
WebDewey or Abridged WebDewey. 

Action

1 Find the text file that contains your Dewey for Windows user notes, ddw.not.
The file resides in the folder where you installed Dewey for Windows.
The installation folder is named dfw if you installed Dewey for Windows in the 
default location.

2 Open the ddw.not file with Windows Notepad or another text editor.

To start Notepad, click Start, Programs, Accessories, Notepad.

In Notepad, open the File menu and click Open. Navigate to the Dewey for 
Windows installation folder and select the ddw.not file.

DFW notes file structure. For each DFW note, the ddw.not file contains the 
following fields:

DN (Dewey number)
RT (type of note)
KW (keywords)
NT (note text)

3 In the ddw.not file, find a note you want to reproduce in WebDewey or 
Abridged WebDewey.
Go to the first note in the file or search for a specific note.

You can search for text (such as a DDC number or a word from a note title) in 
Notepad.
Open the Edit menu and click Find. Type the text you want to find and click 
Find Next.

4 Start your browser and log on to WebDewey or Abridged WebDewey.

5 On the Dewey Services tab, under Create Options, click User Notes or Abr. 
User Notes.
A blank note workform appears.

6 In Notepad, select and copy the text you want to include in the new user note.
Highlight the text with the mouse. Then open the Edit menu and click Copy.

7 In WebDewey or Abridged WebDewey, paste the copied text into the desired 
field in the user note workform.

8 Complete the user note and save it.

9 Repeat steps 5 through 8 for each user note you want to recreate.
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Institution notes and 
personal notes

Institution notes Personal notes

Can be created only by users with a site 
license.

Can be created by any user of 
WebDewey or Abridged WebDewey.

Accessible to all users at an institution. Accessible only to the user who creates 
the note.

Associated with OCLC institution 
symbol.

Associated with a user’s authorization 
number.

Reside in library’s Dewey notes 
database.
The same database contains personal 
notes created by authorized staff.

For single users, the Dewey notes 
database contains only personal notes.
For institutions (site licenses), the 
Dewey notes database contains both 
institution notes and personal notes

Document, explain, or illustrate 
cataloging standards and practices 
relevant to a library’s Dewey catalogers.
Store decisions, guidelines, tips, and 
examples for reuse by multiple staff 
members.
Save time and promote consistent 
classification.

Document, explain, or illustrate 
cataloging standards and practices 
relevant to an individual’s cataloging 
tasks.
Store decisions, guidelines, tips, and 
examples for reuse by an individual 
cataloger.
Save time and promote consistent 
classification.
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2 View and edit Dewey user notes

View user note within 
DDC record

View user note from 
search results

Action

1 View a DDC record.

2 In the top right corner of the record screen, click the User Notes button to jump 
to the User Notes area.
No user notes. If the record contains no user notes, the User Notes button 
does not appear in the record.

User notes attached to the record appear in a separate area labeled User 
Notes, immediately following the Notes area.
If the record contains no Notes area, the User Notes area appears after the 
hierarchy display.

Return to DDC record. To resume viewing the DDC record,
On the Dewey Services tab, under Search Options, WebDewey or Abr. 
WebDewey, click Search Results. At the results list, select the record you 
were viewing.
Or
On the Dewey Services tab, under Browse Options, WebDewey or Abr. 
WebDewey, click Browse Results. At the results list, select the record you 
were viewing.

Action

On the Dewey notes results screen,
Click the hyperlinked title for the user note you want to view.
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Edit user note from 
DDC record

Edit user note from 
search results

Display DDC record 
from user note

Action

1 View a DDC record.

2 In the top right corner of the record screen, click the User Notes button to jump 
to the User Notes area.
No user notes. If the record contains no user notes, the User Notes button 
does not appear in the record.

In the User Notes area, find the note you want to edit.
Click the Edit button that follows the note title.
The note appears in edit mode.

Return to DDC record. To resume viewing the DDC record,
On the Dewey Services tab, under Search Options, WebDewey or Abr. 
WebDewey, click Search Results. At the results list, select the record you 
were viewing.
Or
On the Dewey Services tab, under Browse Options, WebDewey or Abr. 
WebDewey, click Browse Results. At the results list, select the record you 
were viewing.

Action

Single note (display mode)
Open the Actions list and click Edit Note.
Or
Results list
Click the Edit button in front of the title of the note you want to edit.
The note appears in edit mode.

Action

1 If not in edit mode, open the Actions list and click Edit Note.

2 In the Editing Note screen, open the Actions list and click Display DDC 
Record.
Note: The Display DDC Record action is not available for general user notes 
not associated with a specific DDC number.

3 Return to user note from DDC record
In the DDC record, move to the User Notes section.
Click Edit.
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Save user note

Logoff warning for 
active user notes

When you click Logoff to end a session, the system checks for user notes in 
edit mode, including new notes not yet saved in the Dewey notes database.

The system displays a message to remind you to save the active notes before 
exiting.

To return to the note(s), on the message screen click Show Active Records or 
press <Ctrl><Shift><9>, Or, on the Dewey Services tab, click Show or press 
<Alt><4>. At the Active Records screen, under WebDewey User Notes or 
Abridged WebDewey User Notes, click a hyperlink to view the note you want. 
Notes are identified by title. Note workforms not yet saved are also identified by 
title. For a Note workform without a title, the hyperlink text is No Title Provided.

To log off and discard unsaved changes to the active user note(s), on the 
message screen click Logoff immediately.

Turn off logoff warning for active records

If you prefer not to be notified about active records before logging off, use the 
Show or Hide Logoff Warning option to prevent the system from displaying 
this warning. To view or change the setting, do one of the following:
—From the End Your Session screen (the logoff warning), go directly to the 

Interface Customization Options screen by clicking Customize your setting.
Or

—On the General tab, click Admin. On the Preferences screen, click General 
Options. Then click Interface Customization Options. On the Interface 
Customization Options screen, find the Show or Hide Logoff Warning 
option and select Hide.

Resume editing user 
note

If you interrupt your work on a user note (for example, to retrieve a related note or 
search WebDewey or Abridged WebDewey), use the Active Records screen to 
return to a note you are editing.

Action

1 If not in edit mode, open the Actions list and click Edit Note.

2 In the Editing Note screen, open the Actions list and click Save Note.

3 Click OK to confirm that you want to save the note.
Or
Click Cancel if you decide not to save the note now.
The system displays a confirmation message.

DDC number check (new user note)
When you save a new user note for the first time, the system searches the 
WebDewey or Abridged WebDewey database for the number you supplied in 
the DDC Number field of the user note.
If the number you supplied does not exist in the DDC database searched, the 
system asks you to decide whether or not to save the note.
To save the note anyway, click Yes.
To cancel saving the note and correct it as appropriate, click No.
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Delete user note

Derive a new user note 
from an existing note

Action

1 Press <Ctrl><Shift><9>.
Or
On the Dewey Services tab, under Show Options, click Active User Notes or 
press <Alt><4>. 

2 At the Active Records screen, under WebDewey User Notes or Abridged 
WebDewey User Notes, click the hyperlink for the note you want.

The Active Records screen shows the following types of hyperlinks for active 
user notes:

Notes are identified by title.
Note workforms not yet saved are also identified by title.
For a Note workform without a title, the hyperlink text is No Title Provided.

Action

1 Single note (display mode or edit mode)
Open the Actions list and click Delete Note.
Or
Results list
Click the title of the note you want to delete.
Open the Actions list and click Delete Note.

2 Click OK to confirm that you want to delete the note.
Or
Click Cancel to keep the note in the database.

Action

1 Search the Dewey notes database to retrieve the note you want to use as a 
model for creating similar notes.
Or
Create a note with characteristics you want to replicate in one or more other 
notes (a template note).
View the note in display mode or edit mode.

2 Open the Actions list and click Derive New Note.
Click OK to confirm that you want to duplicate the note.
An exact copy of the original Dewey note appears, in edit mode.
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Work area: build a 
DDC number

Use the work area to
—Build a classification number incrementally. Type a base number in the work 

area box and then add to the number as you read number-building 
instructions.

—Keep the number you are building on the screen while viewing relevant 
schedule and table records, following instructions in add tables, consulting 
Manual entries, or checking user notes.

The work area appears by default at the top of results lists, schedule and table 
records, and user notes.

Work area dialog box. The work area does not remain in view as you scroll 
down through a long record. To continue building a number in the work area 
without scrolling up and down, use the work area dialog box. Press 
<Alt><Shift><.> (period) to open the dialog box. Type the data you want to add 
to the number you are building. Then click OK or press <Enter> to store the 
information in the work area.

If you do not use the work area, you can hide it by changing the default setting. 
On the Dewey Services Options screen, under DDC Record Options, change 
the Work Area setting to Hide.

If you use the work area occasionally, leave the option set to Show. Then, to 
show or hide the work area as needed, press <Alt><W>.

Contents of the work area are retained between Connexion sessions. The work 
area is not cleared when you log off.

Browser requirements: The work area is available only in supported versions 
of Internet Explorer with cookies enabled.

3 Complete the new note.
Add, delete, or change text to provide appropriate information or instructions.
Fill in the required fields: Title, Type of Note, and Note.
Proofread the note and correct any errors.

4 Add the note to the notes database.
Open the Actions list and click Save Note.
Click OK to confirm that you want to save the note.
The system displays a confirmation message.

DDC number check (new user note)
When you save a new user note for the first time, the system searches the 
WebDewey or Abridged WebDewey database for the number you supplied in 
the DDC Number field of the user note.
If the number you supplied does not exist in the DDC database searched, the 
system asks you to decide whether or not to save the note.
To save the note anyway, click Yes.
To cancel saving the note and correct it as appropriate, click No.

Action
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User note actions 
summary

Work Area function How to use

Show or hide work area On a Dewey Services results, record, or user 
note screen,

Press <Alt><W>.
Note: The keystroke works only if the Work 
Area option is set to Show in Dewey Services 
Options.

Move cursor to work area Press <Alt><.> (period).
Connexion places the cursor in the work area 
and highlights any existing text.

Open work area dialog box Press <Alt><Shift><.> (period).
The dialog box appears, containing any data 
currently stored in the work area.

Close work area dialog box; 
save changes to the data 
stored in the work area

Click OK or press <Enter>.
The contents of the work area are updated with 
any changes made since you opened the dialog 
box.

Close work area dialog box; do 
not save changes to work area 
contents

Click Cancel.

Change Work Area setting
Default: Show

1. On the General tab, under Admin Options, 
click Preferences. At the Preferences 
screen, click Dewey Services Options.

2. On the Dewey Services Options screen, 
under DDC Record Options, select Show or 
Hide for the Work Area item.

3. To use the setting for the current session only, 
at the top or bottom of the Dewey Services 
Options screen, click Save for Session. To 
use the settings for future sessions, click 
Save My Default.

Context Action Meaning/Purpose

Displaying a user 
note (not in edit 
mode)

Edit Note Go to edit mode to modify the note.

Derive New Note Generate an exact copy of the 
current user note to begin creating a 
similar user note.

Delete Note Remove the displayed note from 
your library’s Dewey user notes 
database.

Editing a user note 
(in edit mode)

Display Note Go to a display view of the user note 
you are editing.

Cancel Changes Discard changes made to the user 
note since you began editing.
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Delete Note Remove the note from your library’s 
Dewey user notes database.

Derive New Note Generate an exact copy of the 
current user note to begin creating a 
similar user note.

Display DDC Record Display the DDC record associated 
with the note. Available for notes 
that refer to a specific class number.

Save Note New user note. 
Add the user note you are editing to 
your library’s Dewey user notes 
database.
Existing user note (modified).
Use the edited version of the user 
note to replace the previous version 
in your library’s Dewey user notes 
database.

Displaying a user 
note (in edit mode)

Back to Editing Return to the edit view of the user 
note.

Cancel Changes Discard changes made to the user 
note since you began editing.

Delete Note Remove the note from your library’s 
Dewey user notes database.

Derive New Note Generate an exact copy of the 
current user note to begin creating a 
similar user note.

Display DDC Record Display the DDC record associated 
with the note. Available for notes 
that refer to a specific class number.

Context Action Meaning/Purpose
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Editing techniques for 
user notes

Technique How to

Change text Use standard editing keys (<Insert>, <Backspace>, <Delete>, 
arrow keys) to move the insertion point and remove/add 
characters.

Clear text Press <Backspace> or <Delete> to delete text.
Or
Select the text. In the browser's menu bar, open the Edit menu 
and click Cut.
Or right-click the selected text; on the popup menu click Cut.

Undo text 
changes

To reverse the most recent text change, use the standard 
Windows undo keystroke: <Ctrl><Z>.
The following functions are supported in recent browser 
versions. Specific functionality may change with browser 
upgrades. Check browser Help or documentation for details.
Undo last change, current text box:
Press <Ctrl><Z> once.
Undo series of changes, current text box:
Press <Ctrl><Z> once to reverse each change, beginning with 
the last.
Undo series of changes in different text boxes:
Place the insertion point in the desired text box and then press 
<Ctrl><Z>.
Begin with the text box most recently modified and return to 
the other text boxes in reverse order (retrace your steps).

Notes on browser-based Undo
Browser dependent. Support for <Ctrl><Z> varies with 
browser name and version.
Refresh clears undo memory. If you take an action that 
refreshes the screen (for example, select an item on the 
navigation bar, the Actions list, or the Functions list for a field), 
the undo memory is cleared.
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3 Search Dewey user notes

Why search for Dewey 
user notes?

Review notes associated with a DDC number you want to use to classify an 
item.

Check for information on standards and practices applicable to the material you 
are cataloging.

Find a note to use as a template for creating similar notes.

Find specific Dewey 
user notes

Action

1 On the Dewey Services tab, under Search Options, WebDewey or Abr. 
WebDewey, click User Notes or Abr. User Notes.
Keystrokes.

Press <Ctrl><Shift><[> (left square bracket) to search WebDewey notes
Or press <Ctrl><Shift><]> (right square bracket) to search Abridged 
WebDewey notes.

The Search WebDewey User Notes screen or the Search Abridged 
WebDewey User Notes screen appears.

2  Construct a search to specify the user note(s) you want to retrieve.
Type search term(s) in the Search for box. Spaces between words are 
treated as and operators; you can also combine terms with or and/or 
exclude terms with not.
Select the index to search from the list to the right of the Search for box. 
Click the arrow to open the list; then click the index you want to use.
Use truncation to expand a term to include variant endings. Or use 
truncation when you know only part of a term. Truncation is useful when 
searching for a DDC number, a word, or a multiword term.
Right truncation. Type the first characters of the word or the first par of the 
number (include as many letters/digits as you know); then type an asterisk 
(*). Examples: 610*, librar*, comput*, war*, catalog*
Left truncation. Type an asterisk (*) and then type the last part of the term. 
Examples: *073, *crime, *net
Use character masking (wildcards) to expand a term to include variant 
spellings or when you are unsure of the correct spelling for part of a term. 
Type a question mark (?) or a number sign (#) in place of the character(s) 
you want to mask. Use the question mark to retrieve variants of 0 or more 
characters. Examples: col?r retrieves color or colour; int?net 
retrieves internet or intranet. Use the number sign to retrieve 
variants of exactly 1 character. Example: wom#n retrieves both woman 
and women.

3 (Optional) Pre-sort search results.
To specify sort criteria for retrieved user notes, 
Under Sort results by:, select up to 3 fields by which to sort retrieved notes. 
For each field, select Ascending or Descending.
Default setting: No sort criteria. Results are sorted by DDC number; notes 
not associated with a DDC number appear at the end of the results list.
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List all your library’s 
Dewey user notes

4 (Optional) Limit search by type of note (requires site license).
Under Limit results by:, select the type of note to retrieve: Institution or 
Personal or All.
Default setting: All.
Not available with single-user license. If you have a single-user license for 
WebDewey or Abridged WebDewey, the Limit results by: option is not 
available.

5 Check the search form for errors in the terms, index selection, sort options, or 
the Type of Note limit.
Clear search

To clear the Search for text box, click Clear Search.
The index list retains the last index you selected.
The sort options and the Type of Note limit revert to the default settings.
The Retain Search check box retains its setting (selected or cleared).

6 Click Search or press <Enter>.
The system displays the Dewey note(s) that match the search criteria.
Retain search

To preserve text in the Search for text box, as well as sort options and Type 
of Note limit, select the Retain Search check box.
If Retain Search is not selected (the default setting), the system clears 
the Search for text box. The index list always retains the last index you 
selected.
If Retain Search is not selected, the system restores default settings for 
sort options and the Type of Note limit.
The setting for the Retain Search check box is retained until you change it.

Action

Action

1 On the Dewey Services tab, under Search Options, WebDewey or Abr. 
WebDewey, click User Notes or Abr. User Notes.
The Search WebDewey User Notes screen or the Search Abridged 
WebDewey User Notes screen appears.

2 In the search form, leave the Search for text box empty.
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Search history: view 
and use previous 
searches

Use the Search History window to
—View your previous 10 user note searches.
—Repeat a previous search.
—Revise a previous search.

Previous searches are associated with your authorization number and are 
retained between Connexion sessions. The search history is not cleared when 
you log off.

Note: Separate search histories exist for the following: Quick Search/Quick 
Browse area, Search WebDewey screen, Browse WebDewey screen, and 
Search WebDewey User Notes screen.

3 (Optional) Pre-sort search results.
To specify sort criteria for retrieved user notes, 
Under Sort results by:, select up to 3 fields by which to sort retrieved notes. 
For each field, select Ascending or Descending.
Default setting: No sort criteria. Results are sorted by DDC number; notes 
not associated with a DDC number appear at the end of the results list.

4 (Optional) Limit search by type of note (requires site license).
Under Limit results by:, select the type of note to retrieve: Institution or 
Personal or All.
Default setting: All.
Not available with single-user license. If you have a single-user license for 
WebDewey or Abridged WebDewey, the Limit results by: option is not 
available.

5 Check the search form for errors in sort options or the Type of Note limit.
Clear search

To restore default settings for sort options and the Type of Note limit, click 
Clear Search.
The Retain Search check box retains its setting (selected or cleared).

6 Click Search or press <Enter>.
The system displays a list of your library’s Dewey user notes.
Retain search

To preserve settings for sort options and Type of Note limit, select the 
Retain Search check box.
If Retain Search is not selected (the default setting), the system restores 
default settings for sort options and the Type of Note limit.
The setting for the Retain Search check box is retained until you change it.

Action

Search History function How to use

Open Search History window At the Search WebDewey User Notes screen or 
the Search Abridged WebDewey User Notes 
screen, 

Click Search History or press <Alt><=>.
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Dewey user notes 
search indexes

List of previous searches For each listed search, the window shows
Search type: Dewey Notes or Abridged 
Dewey Notes.
Timestamp: date and time the search was 
performed.
Search criteria: all search elements, including 
terms, indexes, and sort options and type of 
note.

Repeat a previous search Click Repeat.
Connexion immediately performs the selected 
search.

Revise a previous search Click Revise.
Results

Connexion displays the Search WebDewey 
User Notes screen or the Search Abridged 
WebDewey User Notes screen. The selected 
search is ready for revision.

Clear search history Click Clear History (at the top of the Search 
History window).

Close the Search History 
window

Click Close (at the top of the Search History 
window).

Search History function How to use

Index (label) Included Fields Example Tips/Why use?

All Fields 
(al:)

All fields/data 
included in all 
indexes of the 
Dewey user notes 
database

fiction Improve results when a 
search on another index 
produces too few hits.
Find all occurrences of a 
term in the user notes 
database.

DDC 
Number (dc:)

DDC numbers (from 
schedules, tables, or 
manual) that 
associate a user 
note with the DDC 
record to which it 
applies

660 Find all user notes 
associated with a specific 
DDC number.
Use truncation to match all 
DDC numbers that begin 
with the same sequence of 
digits.
Not all user notes are 
associated with DDC 
numbers. The DDC number 
field is not required.

Keyword 
(kw:)

Keywords supplied 
by the creator or 
editor of a user note

bibliograph* Find a note by searching for 
term(s) that describe the 
topic you want.
Not all user notes include 
keywords. The Keywords 
field is not required.
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Combine terms in one 
index

Characters to omit 
from user notes 
searches

The following characters and symbols appear in WebDewey search results and/or 
DDC records as part of a class number, caption, or other text. They are not 
included in indexes for the user notes database. Omit these characters from terms 
when searching for user notes.

Title (la:) Words and Dewey 
numbers in the titles 
of user notes

electronic 
book

Find a note when you know 
the title or part of the title.
Determine whether a term is 
part of the title of an existing 
user note.

Note (nt:) Words and Dewey 
numbers in the Note 
fields of user notes

cutter* Find occurrences of term(s) 
for the topic you want in the 
body of a user note.

Index (label) Included Fields Example Tips/Why use?

To specify Enter Example

Multiple terms, 
all terms required 
(AND)

[term1] [term2]
Or
[term1] and [term2]
A space between terms is 
treated as an and.

transportation safety

Multiple terms, at 
least one term 
required (OR)

[term1] or [term2] radiography or radiology

One or more 
terms that must 
not be found 
(NOT)

[term1] [term2] not [term3]
Or
[term1] or [term2] not [term3]

college education not 
secondary

One or more 
groups of terms 
combined with 
other terms 
(parentheses)

[term1] ([term2] or [term3])
[term1] or ([term2] or [term3])
[term1 or ([term2] [term3])

education (college or 
university)
graduate or (college or 
university)
graduate or (college 
university)

Characters to 
omit Example Purpose of characters

Diacritics Provençal
Omit cedilla when searching: 
Provencal

Indicate pronunciation of non-
English words.

Asterisk (*), 
dagger (†), and/
or double 
dagger (‡) in 
captions

*Administration of general 
forms of control
† Latin dramatic poetry and 
drama
‡*Visual programming

Indicate that a record contains 
a footnote marked with that 
symbol.
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4 View retrieved Dewey user notes

Results display

Query display At the top of the first screen of results, the system displays a message that 
includes the number of user notes retrieved and the query that produced the 
results. The message provides feedback that lets you see how the system 
interpreted your search criteria.The display shows:

Each term preceded by an index label identifying the index in which it was 
searched. Example:   dc: (“610”)

Term groups (terms entered in the same box on the search form and searched 
in the same index). Example:   kw: (special collection)

Number of Notes 
Found Results Display

No user notes found The system displays the following message at the top of 
the Search screen:
No Records Found for Your Search
Please change or simplify your search and 
try again.

1 user note found The full user note appears, in display mode.

Up to 10 user notes The system displays the message:
[number] records found searching for 
[search query] in [WebDewey or Abridged 
WebDewey] User Notes 

The results screen lists the DDC number (if any) and 
title for all retrieved notes.
Brief entries for notes appear in DDC-number order. 
Notes not associated with a DDC number appear last.
When multiple notes for the same DDC number are 
retrieved, the note most recently added is listed first.

11 or more user 
notes

The system displays the message:
[number] records found searching for 
[search query] in [WebDewey or Abridged 
WebDewey] User Notes 

The results screen lists the DDC number (if any) and 
title for the first 10 retrieved user notes.
The View List box lets you type an entry number to 
display 10 entries beginning with that number. The left 
and right arrow buttons let you move forward or back 
10 entries. The View Record box lets you type an 
entry number to view the full note.
Brief entries for notes appear in DDC-number order. 
Notes not associated with a DDC number appear last.
When multiple notes for the same DDC number are 
retrieved, the note most recently added is listed first.
page 25 of 29



Create and Manage Dewey User Notes
For all queries, terms that specify the type of note to retrieve. For institution 
notes, the query includes the institution symbol. Example:   tn: (iOCL). For 
personal notes, the query includes the user’s authorization number. Example:   
tn: (p000000000). To retrieve all notes, the query combines the terms. 
Example:   tn: (iOCL) OR tn: (p000000000)

Use the displayed query to

Diagnose causes for unsatisfactory search results.

Refine your search to improve results.

Sort retrieved user 
notes (1,000 or fewer 
notes)

Move through list 
(View List and View 
Record jump bar)

The View List jump bar appears at the top and bottom of each screen of the 
results list.

The View Record jump bar appears at the top and bottom of each screen of 
the results list.

Action

1 Scroll to the top of the first screen of search results.

2 Open the Actions list and select Sort by DDC Number or Sort by Title or 
Sort by Type of Note.

More than 1,000 notes found. If your search retrieves more than 1,000 notes, 
sort options are not available.

Pre-sort results. On the search screen, you can specify multiple sort criteria 
for retrieved user notes. 

Action How to

Move forward 10 
entries

Click the right arrow button (right of View List box).

Move back 10 
entries

Click the left arrow button (left of View List box).

View 10 entries 
beginning with 
specific entry

Type an entry number in the View List box and press <Enter>.

View a specific 
record

Click the hyperlinked entry number for the record you want to 
view.
Or
Type an entry number in the View Record box and press 
<Enter>.
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Move between user 
notes (View Record 
jump bar)

The View Record jump bar appears at the top and bottom of each record 
screen.

The record position indicator (Record _ of _) appears at the top and bottom of 
each record screen. As you move through the records, the indicator changes to 
reflect your current position in the results list.

Work area: build a 
DDC number

Use the work area to
—Build a classification number incrementally. Type a base number in the work 

area box and then add to the number as you read number-building 
instructions.

—Keep the number you are building on the screen while viewing relevant 
schedule and table records, following instructions in add tables, consulting 
Manual entries, or checking user notes.

The work area appears by default at the top of results lists, schedule and table 
records, and user notes.

Work area dialog box. The work area does not remain in view as you scroll 
down through a long record. To continue building a number in the work area 
without scrolling up and down, use the work area dialog box. Press 
<Alt><Shift><.> (period) to open the dialog box. Type the data you want to add 
to the number you are building. Then click OK or press <Enter> to store the 
information in the work area.

If you do not use the work area, you can hide it by changing the default setting. 
On the Dewey Services Options screen, under DDC Record Options, change 
the Work Area setting to Hide.

If you use the work area occasionally, leave the option set to Show. Then, to 
show or hide the work area as needed, press <Alt><W>.

Contents of the work area are retained between Connexion sessions. The work 
area is not cleared when you log off.

Browser requirements: The work area is available only in supported versions 
of Internet Explorer with cookies enabled.

Action How to

View next record 
in list

Click the right arrow button (right of View Record box).

View previous 
record in list

Click the left arrow button (left of View Record box).

View a specific 
record

Type an entry number in the View Record box and press 
<Enter>.

Return to search 
results

Click the Search Results button at the top or bottom of the 
record screen.
Or
On the Dewey Services tab, under Search Options, 
WebDewey or Abr. WebDewey, User Notes, click Search 
Results.
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Edit user note

Work Area function How to use

Show or hide work area On a Dewey Services results, record, or user 
note screen,

Press <Alt><W>.
Note: The keystroke works only if the Work 
Area option is set to Show in Dewey Services 
Options.

Move cursor to work area Press <Alt><.> (period).
Connexion places the cursor in the work area 
and highlights any existing text.

Open work area dialog box Press <Alt><Shift><.> (period).
The dialog box appears, containing any data 
currently stored in the work area.

Close work area dialog box; 
save changes to the data 
stored in the work area

Click OK or press <Enter>.
The contents of the work area are updated with 
any changes made since you opened the dialog 
box.

Close work area dialog box; do 
not save changes to work area 
contents

Click Cancel.

Change Work Area setting
Default: Show

1. On the General tab, under Admin Options, 
click Preferences. At the Preferences 
screen, click Dewey Services Options.

2. On the Dewey Services Options screen, 
under DDC Record Options, select Show or 
Hide for the Work Area item.

3. To use the setting for the current session only, 
at the top or bottom of the Dewey Services 
Options screen, click Save for Session. To 
use the settings for future sessions, click 
Save My Default.

Action

Click the Edit button in front of the title of the note you want to edit.
The note appears in edit mode.
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Delete user note

Print screen of results

Action

1 Single note
Open the Actions list and click Delete Note.
Or
Results list
Click the title of the note you want to delete.
Open the Actions list and click Delete Note.

2 Click OK to confirm that you want to delete the note.
Or
Click Cancel to keep the note in the database.

Action

1 If the list includes multiple screens, jump to the screen you want to print.

2 Click once in the frame that contains the results list.

3 In your browser, on the File menu, click Print or on the toolbar click the Print 
button.

4 In the Print dialog box, click OK or press <Enter>.
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